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1 Introduction

This document describes the use and maintenance of the JEM-X “Instrument Station” software.

The manual provides information needed by user to understood the purpose of the program and its role
in the testing of the JEM-X instrument during the followed phases of development. This includes a
general overview and procedures for preparing, starting and using the system.

1.1 Purpose and scope

This Document is applicable to the * Instrument Station ” program version 3.22.

This manual is intended for readers with basic knowledge of EGSE systems, computers, and software.
No elementary information on those topics is given, and it gives no assistance with analysis of
information in status windows and real-time graphical displays. It has been assumed that the user is
familiar with the Windows NT interface. Therefore no explanation are provided for standard
commands and buttons.

1.2 Manual conventions

This manual uses the following special fonts:
Couri er type represents text that you type or text as it appears onscreen.

Italics are used to emphasize and introduce words, and to indicate variable names
(identifiers), function names, window names, and structure names.

Bold type indicates reserved keywords, format specifiers, and command-line options.

Keycap type represents a particular key you should press on your keyboard. For
example, "Press Del to erase the character."”

Keyl+Key2 indicates a command that requires you to press Keyl with Key2. For example,
Shi f t +a (although not a command) indicates the uppercase letter "A."

ALL CAPS type represents disk directories, file names, and application names

Menu|Choice represents menu commands. Rather than use the phrase "choose the Save
command from the File menu," manual use the convention "choose Eile|Save”
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1.3 Applicable and reference documents

10.

11.

12.

EID-B - X-Ray Monitor for
The INTEGRAL Mission

IASW for JEM-X /DPE-
Software Specification Document

PEPbug User's Manual
VM62/VM42-User’s Manual
CXC Schematics User’s Manual
CXM-SCSI User’s Manual
CXM-IMOD User’s Manual

VMOD-2/VVMOD-2D User’s
Manual

CXM-S103-0 User’s Manual;
PB-ADC3 -User’s Manual

JEM-X EGSE
Technical Description

JEM-X "EGSE Control""
Users Manual

Issue 4.0

ver 1.9

Issue 1.0.1
Issue 4
Preliminary
Issue 1
Issue 6.0.1

Rev. 0200

Issue 1
Issue 3

Issue 2.2

Issue 1.2

1995 PEP Modular Computers
1995 PEP Modular Computers
1993 PEP Modular Computers
1992 PEP Modular Computers
1996 PEP Modular Computers

1997 PEP Modular Computers

1996 PEP Modular Computers
1994 PEP Modular Computers

(JEMX-EGSE-01)

(JEMX-EGSE-03)
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2 Installation and setup procedures
It is recommend a 300MHz or better Pentium computer with at least 64Mbytes of RAM running

Windows NT4 or Windows 95/98 (the software has not been qualified or tested for Windows 2000).
For best system performance we suggest you use a 17-inch monitor and 4Mbyte graphics card
displaying 1024x768 pixels.
2.1 Installation

1. Open DOS window (for WIN95 or NT)

2. Insert DISK #1 to drive A:

3. Run INSTALL1.BAT

4. Insert DISK #2 to drive A:

5. Run INSTALL2.BAT
6. Return to Windows (type EXIT command)
y

. Using NOTEPAD program (or other editor for text files) add contents of file
C:EGSENIDAPNIDAPLINI to the end of WIN.INI file (should be located in WINDOWS or
WINNT directory).! The section [IDAPI] should be added only ONES !

[IDAPI]
DLLPATH=C:\EGSE\IDAPI
CONFIGFILEO1=C:\EGSE\EGSEBASE.CFG

8 You may put program shortcut ICON into desktop.

Directory structure: (NOW FIXED!!)

C:\EGSE\ ;programs
+ BASE ;setup database & log (initially EMPTY)
+ DATA ;instrument data files (examples only)
+ IDAPI ;database system DLL’s
+ SCRIPTS ;script files (examplel.scp)

2.2 Setup Procedures
When successfully installed, application does not require special set up activity.
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3 Menu commands

The menu bar includes File, View, Tools, Setup, Window, and Help menus, which contain program
basic commands. Additionally most of views have its own operational menu that will be merged into
main menu. When the child window (view) is created, its pop-up menu, called "Data", is automatically
placed between the "File" and "View" menu. Additionally, most of created windows maintain
themselves SpeedMenus. The SpeedMenus contain commands that are context sensitive to the area of
the program you are working in. Right-clicking (click the right mouse button) accesses the menu
command associated with focused window or dialog.

3.1 The tool bar

The Toolbar is a row of buttons at the top of main window, which represent application commands.
Clicking one of the buttons is a quick alternative to choosing a command from the menu. Buttons on
the toolbar activate and deactivate according to the state of the application. The JEM-X EGSE software
provides you with the ability to perform frequently used commands without accessing the application
menus. Please note that there is no way to select these buttons using the keyboard - the equivalent
commands can be found in the menus.

= JEM-X Instrument Station =]
File “iew Toolz Setup Window Help

Figure 3-1 Program menu bar and tool bar.

Telemetry packets processing and display

Button TM format Menu Equivalent

ALL BLOCKS View|TM Data Block

------ - HOUSEKEEPING View|HK Data List

HOUSEKEEPING View|HK Data Monitor
HOUSEKEEPING View|HK Calibration Spectra

=

m

FULL IMAGING View|Full Imaging Blocks

e RESTRICTED IMAGING  View|Restricted Imaging Blocks
— SPECTRAL/TIMING View|Spectral/Timing Blocks
e COUNTRATE View|CountRate Blocks

'y SPECTRUM View|Spectrum Blocks

. TIMING View|Timing Blocks
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3 TEST View|Test Blocks
=] DIAGNOSTIC View|Diagnostic Blocks
=1 CALIBRATION View|Calibration Blocks
= CALIBRATION View|Calibration Monitor
Other Commands
Button Action Menu Equivalent
Display/Hide log window View|Program Log

Print the active window Eile|Print

Preview the printout Eile|Print Preview
Display help file contents Help|Contents

w3 o) M

3.2 The status bar

The Status Bar at the bottom of the program main windows contains "flyby" help hints, when the
cursor is over a button or points to menu command. Additionally, the bitmap gadgets (lamps) located
on the right side indicates status of socket connection and current archive file name and location.

|File: | CAEGSELDATAYLCEELIPF | Connection [ |
Figure 3-2 Program status bar.

3.3 File menu commands

New

Opens a new IPF document file. Existing documents will be closed when opening a new
document.

Open...

Opens a new window with the contents of an existing document/file.

The application can open an IPF type data file. Select the appropriate drive and directory, enter
a file to open and choose the OK button. The default directory for the File Open command is
set to C:\EGSE\DATA. Once a file is opened the full path and filename is displayed in the
status bar of the main window.

Close



JEM-X Instrument Station | 30 o
Users Manual Date: 26 September, 2001

Page: 12 of 54

Closes the active document window. If the document has unsaved changes, you will be asked
to save the file before closing the window.

Save
Saves the contents of the current window to disk. If the document is UNTITLED, program
prompts you for a file name.

Save As...
Choose the Save As option to save the contents of the active window to a new or different
filename.

Print Preview...

File|Print Preview command opens a special window that shows how the active window/view
will appear when printed. The preview window shows one or two pages of the active document
as they would be laid out on printer pages. Controls on the window allow you to page through
the pages of the document. Displays the current view printout on screen. This command is
disabled if focused window has no printing facility.

Print...

The Eile|Print command prints the contents of the active window/view. Use Eile|Print Preview
to see how the document will be laid out on printer pages. Use Eile|Print Setup to select a
printer, and to set printer options. You can select the page numbers to be printed, if active view
has more than one page.

This command is disabled if focused window has no printing facility.

Printer Setup...

This command displays the system Printer Setup dialog box where you select which printer you
want to use for printing views. Allows you to choose a printer and to access printer options.
This command is disabled if no printer can be detected.

Exit

Close all open windows and exits the “Instrument Station” program. If there is active
connection to telemetry source application prompts .you to disconnect link. All open files are
closed before exiting. If you intend to close all of the open windows/view and not exit
Instrument Station, then choose Window|Close All rather than Eile|Exit.

3.4 View menu commands

The View menu provides commands to create data processing and display windows.

TM Data Block Displays last processed TM Block
HK Data Monitor Displays selected HK data as list of plots
HK Data List Displays Housekeeping data as numbers

HK Calibration Spectra Displays calibration spectra from HK packets
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Full Imaging Blocks Processing and display of FULL IMAGING

format data

Restricted Imaging Blocks  Processing and display of RESTRICTED
IMAGING format data

Spectral/Timing Blocks Processing and display of SPECTRAL/TIMING
format data

Count Rate Blocks Processing and display of COUNTRATE format
data

Spectrum Blocks Processing and display of SPECTRUM format
data

Timing Blocks Processing and display of TIMING format data

Test Blocks Processing and display of TEST format data.

Diagnostic Blocks Processing and display of DIAGNOSTIC
format data

Calibration Blocks Processing and display of CALIBRATION
format data

Calibration Monitor Displays CALIBRATION data as plots

Events Count Rate Displays processed events Count Rate (1/sec)

On Event Message List Displays list of "Telemetry On Event Messages"

Program Log Displays application log window

3.4.1 View TM Data Block

This window processes and displays all valid data packets. The menu "Data", merged to main menu
when view window gets focus, lets perform following commands:

Byte format Changes display to BYTE mode (block data are displayed as
separate bytes hex numbers)

Word format Changes display to WORD mode (block data are displayed as
16-bits hex numbers)

Decimal format Changes display to DECIMAL mode (block data are displayed
as integers - two bytes decimal numbers)

Setup Sets the data filter - NOT USED FOR THIS VIEW
Properties Sets View properties
About Displays general information about this view

The sample of such window is shown on Figure 3-3.
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APID: 1le0s Jequence count: 1353
aJtatus: EBlock iz OE. Processed: 1
Format: Full Imaging Type: 0 Subtype: &
oooo - 0800 0824 F422 0067 001F FF77 0018 CEBGE e Bute format
0ol - 5580 DO30 8F56 3BAT 5727 F95C 5388 AdDY ‘whord farmat
0020 - B61F OFAD 2928 5045 6510 FF77 005F 740E |  Decimal format
0030 - 6706 FF32 001D OES86 &&FF 0129 3C07 434Z2 Setup
o040 - F9T7B 6713 FF7?7 003C 5023 5846 394E 8210 Froperties
0050 - 984k 3732 BSES oodF ECTS 4E0S D1DA 46F9
0os0 - FF77 QOBA 9ELS &10F CE33 99C0 D3IsDh 9F&S - About

Figure 3-3 The All block view window.

The window has "freeze" facility it means double clicking the label of window (upper pane) will
disable receiving of data. Double clicking the label again will enable receiving data. The state of view
is indicated by the rectangle on the label window:

» Green rectangle means Enabled

* Red rectangle means Enabled (Frozen).
When enabled, window displays most recent data packet.

View facilities
Freeze \ Printing  Count Rate Pages Number of windows
Yes Yes No 1(3) 2

3.4.2 View HK Data Monitor

Selected housekeeping data could be recorded and display as a list of plots. Use View|HK Data
Monitor command to create monitoring window. Program allows you to create up to four separate
windows of such type (example is shown in Figure 3-4) each of them can collect different sub-set of
HK parameters (up to eight signals), called 'Profile'. This view has printing facility. Up to four plots on
each page will be printed.

Maintained "Data" popup menu and/or 'SpeedMenu' let you change or configure current 'Profile’.
Available commands are listed below:

Command Action

Auto Scale selected Makes Y -axis adjustment to current data for selected plot.
Left-click mouse button when pointing to plot rectangle to
make selection. Selected plot appears to be raised into the list
box window

Clear selected Clears data in associated with plots.

Setup Y axis Create dialog box that lets change the data range to be

displayed
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Auto Scale All Makes Y -axis adjustment to current data for all plot.
Clear All

Clears all data in associated with plots.

Set Profile #1( #2, #3, #4) Changes list of parameters to be displayed as assigned for

profile #1(#2, #3, #4). Command clear all data collected even
new profile is the same as current one.

Setup Creates dialog box that lets you change the sub-set of
displayed parameters for current profile.

Properties Not implemented

About

Displays basic information about this view

SJequnce Count: 127 Processed: 1670
Elock Time: 00:17:16 HE Cycle: 127

00:245 oz:2a 0436 0Fi:44 0452 11:00 13:08 15:16

Figure 3-4 Housekeeping monitor window.

Use the 'Monitoring Setup' dialog box (Figure 3-5) to configure or change data to be collected and
displayed:
1. Run DatalProperties command or use 'SpeedMenu'for creation of this window.
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Monitonn Setup - Prohle #4

Contamer Selected

‘Detector preasure #1
Detector preasure #2
Detector temperature #1
Detector temperature #2

Voltage +5¥ [Digital) _| |_Remove
Current +5% [Digital]

Yaoltage +5Y [Analog) Clear All
Yoltage -5Y [Analog]
Yoltage +12V¥
Current +12%
Yoltage -12¥ j

Add Current +5% [Digital]
— HY PS Temperature #1
Accepted Events

5 Ik

xl:ancel ? Help

Figure 3-5 HK Monitoring set up dialog box.

2. Click Clear All button to remove all selected parameters (optionally)

or click name of parameter in 'Selected’ list and use Remove button to remove selected one,
Select parameter name in the 'Container’ list,

Click Add button - marked item will appear in 'Selected’ list,

Repeat steps 3 and 4 to make required configuration. Up to eight parameters can be selected.
Click OK button to validate changes made or Cancel button to return to the previous
configuration.

o gk w

Note: All previous data will be cleared when new configuration has been approved.

New settings are stored and will be recalled whenever the program re-opens ‘HK Monitoring' window
for this profile.

View facilities

Freeze \ Printing  Count Rate Pages Number of windows
No Yes No Scrolled 4
up to 8 plots

3.4.3 View HK Calibration Spectra

The DFEE part of housekeeping packet (APID 1536 or 1664) contains calibration spectra data. Each
HK-packet contains a "partition number"” (between 0 and 31) and 8 channels from each of the four
spectra. The partition number defines the channel positions in the restored spectra. The window
collects and display reported spectra (example of such window is shown on Figure 3-6). However these
spectra will only be collected when the instrument is in 'Data Taking' mode (regardless of the telemetry
format chosen).
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SJequnce Count: 320 Processzed: 320
HE Cycle: 322 Partition: 1

1] 3z Gid a6 128 160 192 24 256
Channel number #

Figure 3-6 The ""HK Calibration Spectra’ window.

Command Action

Auto Scale selected Makes Y-axis adjustment to current data for selected plot.
Left-click mouse button when pointing to plot rectangle to
make selection. Selected plot appears to be raised into the list
box window

Clear selected Clears data in associated with plots.

Setup Y axis Create dialog box that lets change the data range to be
displayed

Auto Scale All Makes Y-axis adjustment to current data for all plot.

Clear All Clears all data in associated with plots.

Setup Creates dialog box that lets you change the spectra processing
method and displayed plot labels text.

Properties Not implemented

About

Displays basic information about this view

Use the DatalSetup command to create 'Calibration Spectra Setup' dialog box (Figure 3-6) for change
data processing method and/or labels text
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Calibration Spectra Setup

Data processing— -Labels

Spectium #1: ISuur-::e 1A

- Dverwrite Spectrum #2: ISDUTCE #zp

Spectrum #3: ISDUICE #3

Spectium #4: ISuun::e 4

» Axis: Il:hannel number

/ oK I annn:eI ? Help

Figure 3-7 HK Monitoring set up dialog box.

Dat a processi ng
Check spectra processing method
Accurul ati on reported in HK packet spectrum values would be added
(accumulated) to previous one
Overwite reported spectrum values would overwrite (replace) previous one

Label s
Enter the text string for plot labels.

But t ons
OK. closes the dialog box and saves any changes made
Cancel closes the dialog box without saving any changes made
Help opens help window.

View facilities

Freeze \ Printing  Count Rate Pages Number of windows
No Yes No Scrolled 1
4 plots

3.4.4 View HK Data List

Housekeeping data view window display all HK parameters contained in telemetry packets of APID
1536 or 1664.

Label pane presents data processing statistic:
e« Sequence count sequence count number of last received packet,
* Processed number of packets,
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e Block Tine as reported in last processed packet,
 HK Cycle housekeeping cycle number as reported by DFEE.
Jequnce Count: 770 Procezsed: =
Elock Time: 01:43:00 HE Cycle: 70
+ JASW > mATU > DFEE > BCPKT ~ OEMT
DPE Parameters =
Event size 0 b
Actual shutdomm Lewel 0
Wanted shutdomm Lewel 0
Primary format 5
SJecondary format 5
Active format 0
Commatided Grey Filter 100 %
Tsed Grey Filter 100 %
H3L buffer size 4035
H3L buffer Index 4092
Time szince Readout 13
Events Transfered ]
H3L Synch. Status ]
H3L read Actiwve 0
Amount of Events 1
LPE Ewents 494925
Memory Patches ]
Parametres 0OET O-00:00:00, 0000
Spare #1 (1111) 1111 H
-

Figure 3-8 The Housekeeping data view as list window

The window maintains "Data™ popup in main menu and its own 'SpeedMenu’ that lets you change the
data display format or select page to be displayed.
Available commands are listed below:

Command Action

State of IASW Selects IASW page to be displayed
(clicking IASW 'radio button' equivalent)

mRTU data Selects DPE mRTU data to be displayed
(clicking mRTU 'radio button' equivalent)

&DFEE Housekeeping Selects DFEE part of HK to be displayed
(clicking DFEE 'radio button' equivalent)

Broadcast Package Selects Broadcast packets page to be displayed
(clicking BCPKT 'radio button' equivalent)
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On Event Messages

Selects 'On Event Message Telemetry' page to be displayed
(clicking OEMT 'radio button' equivalent)

Hex Format

Decoded Format

Changes display to HEX mode (data are displayed as hex
numbers)

Changes display to DECODED mode (data are displayed as
decimal or converted engineering values)

Setup Not implemented.
Properties Not implemented
About Displays basic information about this view

View facilities
Freeze | Printing  Count Rate Pages Number of windows

YES Yes

No 5 2

3.4.5 View Full Imaging Blocks

The command View|Full Imaging Blocks creates window for processing and display of FULL
IMAGING format data packets. Window receives and processes only TM packets of APID 1608 or
1736. During packet processing the data are encoded and following plots are displayed:

Events XY map

X position histogram
Y position histogram
Energy spectrum
Event time distribution

Label, topmost pane, presents data processing statistic:

Sequence count
Processed

Nurmber of Events
Gey filter

OBT of 1.st Event

sequence count number of last received packet,

number of packets,

current number of events accumulated for plot,

grey filter value as reported in last packet (this is information
only; window do not processes grey filter values for plot
display),

as reported in last processed packet.
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Figure 3-9 The "Full Imaging' data XY map view.

#| Full Imaging M= B3
Seruence count: 4327 Processed: 4325
Iumber of Events : 46965 Grey filter: 100 %
OET of l.=t Ewent: 0-01:30:49,9533

T80 ¥ Histogram Enengy Spectrum
26000 I ) T N
P I
19500 g I~ [ ]
o s ]
13000 P .V B
N T
ga00 - T 1 1]
r ™ 1 1]
0 1 1 1 |
1] 32 64 96 128 160 19: 234 256 1] g 128 192 256
Pasition [#] Channel #]
15700 Y Histogram 4000 Time Distribution

1] 15.6

a3 5.4 2.5
Time [m=]

Pasition [#]

Figure 3-10 The "Full Imaging™ data X and Y histogram view.

The menu "Data”, merged to main menu when view window gets focus, lets perform following

commands:
Command Action
Export map data Saves XY map data to file (ASCII format)
Auto scale XY map Makes Z-axis adjustment to current data for XY Map.

Auto scale XY Histograms Makes Y -axis adjustment to current data for XY
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histograms.

Auto scale Spectrum Makes Y -axis adjustment to current data for spectrum plot.
Auto scale Time distribution Makes Y -axis adjustment to current data for Time

distribution plot.

Auto Scale All Makes Y -axis adjustment to current data for all plots.

Clear All Clears all data in associated with plots and processing
statistic.

Display Map Displays events as XY map (see Figure 3-9)

Display Histograms Displays events as X and Y histograms (see Figure 3-10)

Setup Not implemented for this view

Properties Not implemented

About Displays basic information about this view

View facilities
Freeze \ Printing  Count Rate Pages
No Yes Yes 2

Number of windows

1

3.4.6 View Restricted Imaging Blocks

This command creates view for processing and displays RESTRICTED IMAGING format data.
Created window receives and processes only TM packets of APID 1624 or 1752. During packet

processing the data are encoded and following plots are displayed:

e Events XY map
* Energy spectrum

Label, topmost pane, presents data processing statistic:

e« Sequence count sequence count number of last received packet,

* Processed number of packets,

* Nunber of Events  current number of events accumulated for plot,

e Gey filter grey filter value as reported in last packet (this is information
only; window do not processes grey filter values for plot

display),
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Jequence count: 283 Processed: 284
Mumber of Ewentsz : g6

0BT of l.=t Ewent: 0-01:50:49,01749

Grey filters: Firstc 100 % Last 100 %

1] a2 fidt O 122 160 192 Fk4 2466 Energy Spectrum

Figure 3-11 The ""Restricted Imaging'* data view window

The menu "Data", merged to main menu when view window gets focus, lets perform following
commands:

Command Action

Export map data Saves XY map data to file (ASCII format)

Auto scale XY map Makes Z-axis adjustment to current data for XY Map.

Auto scale XY Histograms Makes Y-axis adjustment to current data for XY
histograms.

Auto scale Spectrum Makes Y-axis adjustment to current data for spectrum plot.

Auto Scale All Makes Y-axis adjustment to current data for all plots.

Clear All Clears all data in associated with plots.

Display Map Displays events as XY map

Display Histograms Displays events as X and Y histograms

Setup Not implemented for this view

Properties Not implemented

About Displays basic information about this view

View facilities
Freeze = Printing  Count Rate Pages Number of windows
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3.4.7 View Spectral/Timing Blocks

The command View|Spectral/Timing Blocks creates window for processing and display
of SPECTRAL/TIMING format data packets. Window receives and processes only TM packets of
APID 1616 or 1744. During packet processing the data are encoded and accumulated. The following
plots are displayed:

* Energy spectrum
« Event time distribution

Label, topmost pane, presents data processing statistic:

« Seguence count sequence count number of last received packet,

* Processed number of packets,

* Number of Events  current number of events accumulated for plot,

e Gey filter grey filter value as reported in last packet (this is information
only; window do not processes grey filter values for plot
display),

e OBT of 1.st Event asreported in last processed packet.

M Spectral/Timing M= E3

Sequence count: 124 Processzed: 125
Mumber of Ewents : 25151 Grey filter: 100 %
OET of l.st Ewent: 0-01:55:30,7945

128 192 266
Enengy channel ¥
[Critz] Time Distribution

o 15.6 3.3 46.9 G245
Delta Time [m=]

Figure 3-12 The "'Spectral/Timing"* view window.

The menu "Data”, merged to main menu when view window gets focus, lets perform following
commands:
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Command Action
Auto Scale All Makes Y -axis adjustment to current data for all plots.
Clear All Clears all data in associated with plots and processing

statistic.

Setup Not implemented for this view
Properties Not implemented
About Displays basic information about this view

View facilities
Freeze \ Printing  Count Rate Pages Number of windows
No Yes Yes 1 1

3.4.8 View Count Rate Blocks

The command View|Count Rate Blocks creates window for processing and display of COUNTRATE
format data packets. Window receives and processes only TM packets of APID 1656 or 1784. During
packet processing the encoded data are displayed as plot (cunts vs. time)

Label, topmost pane, presents data processing statistic:

e Sequence count sequence count number of last received packet,

* Processed number of packets,

* Nunber of Events  current number of events accumulated for plot,

e Gey filter grey filter value as reported in last packet (this is information
only; window do not processes grey filter values for plot
display),

« OBT of 1.st Event asreported in last processed packet.

m_ Count R ate [_ =]

Jequence count: 1 Processed: 2
Iumber of Events : 3166 Grey filter: 3=
0BT of l.st Ewent: 0-01:32:16,4677

3 3206 a3 326 Jz 3226 Ky 3236 34 3246
Time [=]

Figure 3-13 The ""Count Rate™ data view window.



JEM-X Instrument Station | 30 o
Users Manual Date: 26 September, 2001

Page: 26 of 54

The menu "Data”, merged to main menu when view window gets focus, lets perform following
commands:

Command Action

Auto Scale All Makes Y -axis adjustment to current data for all plots.

Clear All Clears all data in associated with plots and processing
statistic.

Setup Not implemented for this view

Properties Not implemented

About Displays basic information about this view

View facilities
Freeze \ Printing  Count Rate Pages Number of windows
No Yes Yes 1 1

3.4.9 View Spectrum Blocks

The command View|Spectrum Blocks creates window for processing and display of SPECTRUM
format data packets. Window receives and processes only TM packets of APID 1640 or 1768. During
packet processing the encoded data are displayed as plot (accumulated spectrum)

Label, topmost pane, presents data processing statistic:

e Sequence count sequence count number of last received packet,

* Processed number of packets,

* Nunber of Events  current number of events accumulated for plot,

e Gey filter grey filter value as reported in last packet (this is information
only; window do not processes grey filter values for plot
display),

« OBT of 1.st Event asreported in last processed packet.
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Jequence count: 53l Processed: S32

Iumber of Events : 14819 Grey filter: 100 %
0BT of l.=t Ewent: 0-0Z:09:01,8883

[Crt=]
F3E00

18850

14160

0 16 32 48 Gid
Energy channel [#]

Figure 3-14 The ""Spectrum' data view window.

The menu "Data"”, merged to main menu when view window gets focus, lets perform following
commands:

Command Action

Auto Scale All Makes Y -axis adjustment to current data for all plots.

Clear All Clears all data in associated with plots and processing
statistic.

Setup Not implemented for this view

Properties Not implemented

About Displays basic information about this view

View facilities
Freeze | Printing  Count Rate Pages Number of windows
No Yes Yes 1 1

3.4.10 View Timing Blocks

The command View|Timing Blocks creates window for processing and display of TIMING format data
packets. Window receives and processes only TM packets of APID 1632 or 1760. During packet
processing the encoded data are displayed as plot (events time distribution)

Label, topmost pane, presents data processing statistic:

« Seguence count sequence count number of last received packet,

* Processed number of packets,

* Number of Events  current number of events accumulated for plot,

e Gey filter grey filter value as reported in last packet (this is information

only; window do not processes grey filter values for plot
display),
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e OBT of 1.st Event asreported in last processed packet.

Sequence count: 40 Proceszed: 106
Mumber of Ewvents : 25738 Grey filter: 100 %
0BT of l.st Event: 0-01:58: 33,0658

Events Time Distribution

1] 2.5 125.0 1875 250.0
Time betwean events [m=]

Figure 3-15 The " Timing" data view window.

The menu "Data”, merged to main menu when view window gets focus, lets perform following
commands:

Command Action

Auto Scale All Makes Y -axis adjustment to current data for all plots.

Clear All Clears all data in associated with plots and processing
statistic.

Setup Not implemented for this view

Properties Not implemented

About Displays basic information about this view

View facilities
Freeze \ Printing  Count Rate Pages Number of windows
No Yes Yes 2 1

3.4.11 View Test Blocks

The command View|Test Blocks creates window for processing and display of TEST format data
packets. Window receives and processes only TM packets of APID 1607 or 1735. This view is mainly
devoted to support instrument calibration and checkout activity when JEM-X is connected to EGSE
rather than satellite subsystems or simulators. The 'real' TEST packet data format, as produced by DPE'
has few data structures. Views data display is divided to several pages:

* Numerical
» Events XY map
« Xand Y position histograms
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* Energy spectrum
* Event time distribution
* Event count rate

Label pane presents data processing statistic:

 Sequence count sequence count number of last received packet,

* Processed number of packets,

e Gey filter grey filter value as reported in last packet (this is information
only; window do not processes grey filter values for plot
display),

e OBT of 1.st Event asreported in last processed packet.

Test Format M 3
Jequence count: 174 Processed: 74
0BT of l.st Ewvent: O0-00:23:05,934:2
Grey Filter 3%
X Histogram

o 128 256 384 412 G40 TGS 206 1024

¥ position #

Y Histogram
40
[ I (N R N N R
. EE EE
’ voobianbe,

1] 128 256 384 512 G40 TGS 206 1024

Y position #

Figure 3-16 The "Test™ data view example - "X and Y histogram' page.

The menu "Data”, merged to main menu when view window gets focus, lets perform following
commands:

Command Action

Export map data Saves XY map data to file (ASCII format)

Numerical Activates display of "Numerical™ page (list of event in last
received block)

XY Map Activates display of "XY map" page

XY Histogram Activates display of "X and Y histograms™ page

Energy Spectrum Activates display of "Energy spectrum" page

Time Distribution Activates display of "Time Distribution™ page

Count &Rate Activates display of "Count Rate" page

Auto Scale All Makes Y -axis adjustment to current data for all plots.
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Clear All Clears all data associated with plots and processing statistic.
Setup Creates "Test data setup” dialog.( see Figure 3-17)
Properties Not implemented
About Displays basic information about this view

When DatalSetup command is executed, the following dialog allows you to change data
processing parameters.

Test data processing setup
- Humerical dizplay =Y Map
 Hex ¥ offzet: Iﬂ ¥ offset: Iﬂ
* Decimal Zoom: - Xi o R2 . X4
- Spectrum Time Distribution —; Countrate
From channel: Il] o b2.5 ms 178 zec
Resolution: > 125 ms * 1 sec
X1 K2 o+ X4 “+ 250 ms - 8 sec

Vo| ([ Xes| | D

Figure 3-17 Test data processing setup dialog.

Nureri cal displ ay
Select required numbers display format (Hex or Decimal).

XY Map
Select map resolution and displacement
X1 - High resolution: 256 x 256 points
X2 - Medium resolution: 512 x 512 points
X4 - Low resolution: 1024 x 1024 points (full detector)

Spectrum
Select spectrum processing resolution and channel offset

Time Distribution
Select time axis range

Count rate
Select count rate accumulation period.

But t ons
OK. closes the dialog box and saves any changes made
Cancel closes the dialog box without saving any changes made

Help opens help window.
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View facilities
Freeze | Printing
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Count Rate Pages Number of windows
Yes 6 1

3.4.12 View Diagnostic Blocks

The command View|Diagnostic Blocks creates window for processing and display of DIAGNOSTIC
format data packets. Window receives and processes only TM packets of APID 1602 or 1730. Views
data display is divided to several pages:

* Numerical

* Events XY map

e Xand Y position histograms
* Energy spectrum

» Event time distribution

» Event count rate

Label pane presents data processing statistic:
« Sequence count sequence count number of last received packet,
* Processed number of packets,

e« OBT of 1.st Event

as reported in last processed packet.

 Anode sw t chas reported in last processed packet.

[@] Diagnostic

I 3

Jequence count:
0BT of l.z2t Event:
Anode switch

358 Processed: 574
0-00:20:19,7512

1]

FInL

1] 256 G512

: I

[0 W o T ot b i s b il e Bl |
it 1024 1280 1536 17492 2048

Channel [#]

Figure 3-18 The ""Diagnostic™ data view example - ""Energy spectrum’ page

The menu "Data”, merged to main menu when view window gets focus, lets perform following
commands:

Action
Saves XY map data to file (ASCII format)

Activates display of "Numerical™ page (list of event in last

Command

Export map data

Numerical
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received block)

XY Map Activates display of "XY map" page

XY Histogram Activates display of "X and Y histograms™ page

Energy Spectrum Activates display of "Energy spectrum" page

Time Distribution Activates display of "Time Distribution™ page

Count &Rate Activates display of "Count Rate" page

Auto Scale All Makes Y-axis adjustment to current data plot (current page).
Clear All Clears all data associated with plots and processing statistic.
Setup Creates "Diagnostic data setup” dialog.( see Figure 3-17)
Properties Not implemented

About Displays basic information about this view

View facilities
Freeze \ Printing  Count Rate Pages Number of windows
No Yes Yes 6 1

3.4.13 View Calibration Blocks

The command View|Calibration Blocks creates window for processing and display of CALIBRATION
format data packets. Window receives and processes only TM packets of APID 1601 or 1729. Views
data display is divided to several pages:

* Numerical

* Energy spectrum

» Event time distribution
e Event count rate

Label pane presents data processing statistic:
« Seqguence count sequence count number of last received packet,
» Processed number of packets,
« OBT of 1.st Event asreported in last processed packet.
e Calibration anplitude asreported in last processed packet.
* Frequency as reported in last processed packet.
* Anode switch as reported in last processed packet.
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[#] Calibration
SJequence count: T4 Proceszsed: 75
0BT of 1.2t Ewvent: O0-00:27:06,0869

Calibr. Amplitude: 12 Frequency: 256
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Time Zlow Fast Veto -
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Figure 3-19 The "Calibration' data view example - ""Numerical™ page.

The menu "Data", merged to main menu when view window gets focus, lets perform following
commands:

Command Action

Numerical Activates display of "Numerical™ page (list of event in last
received block)

Energy Spectrum Activates display of "Energy spectrum™ page

Time Distribution Activates display of "Time Distribution” page

Count &Rate Activates display of "Count Rate" page

Auto Scale All Makes Y-axis adjustment to current data for all plots.

Clear All Clears all data associated with plots and processing statistic.
Setup Creates "Calibration view setup" dialog.

Properties Not implemented

About Displays basic information about this view

View facilities

Freeze | Printing  Count Rate Pages Number of windows
No YES No 4 1

3.4.14 View Calibration Monitor

The command View|Calibration Monitor creates window for processing and display of selected part of
CALIBRATION format data packets. This view is mainly devoted to support instrument calibration
and checkout activity.

Label pane presents data processing statistic:
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« Sequence count sequence count number of last received packet,
* Processed number of packets,

« OBT of 1.st Event asreported in last processed packet.

Calibration Monitor

Sequnce Count: 43 Procezsed: 44
0BT of l.st Ewent: 0-00:03: 59,5407

Slaw Anode

]
2256 N AN o o | N I
1336 I e T A D N =—eea il
418 — ' 1 | [ [ b—] | |

Fast Anode
6,
2652 N A A = oyl R
2040 I S I I
1222 Y Py T
418 —— '/ 1/ I ([L—1 [ |
‘wisto Signal
|
|| [ ]
= L — |

]
2206 I I T N |~
1308 _mm_l-ll | —— [ |
48 L—— 1 =1 [
0z: III4 02:15 0227 0z2:39 02450 0333 0345 03457
Time [=]

Figure 3-20 The "Calibration Monitor" view window.

The menu "Data"”, merged to main menu when view window gets focus, lets perform following
commands:

Command Action

Follow data Switches on or off (according the menu check mark)
automatic Y-axis adjustment to last data inserted to plot.
(scale adjustment follows data values).

Auto Scale All Makes Y -axis adjustment to current data for all plots.
Clear All Clears all data associated with plots and processing statistic.
Setup Creates "Calibration Monitoring Setup” dialog.
(' see Figure 3-21)
Properties Not implemented

About Displays basic information about this view
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When DatalSetup command is executed, the following dialog allows you to change data
processing parameters.

Cahbration Monitorning Setup

‘Plot selection
Param #1  [CIM e -
Param #2  |Fast Anode |
Param #3  [veto Signal =
Param #4 IBa[:k Plane i1 jJ

Vo| ([ Xes| | D

Figure 3-21 The ""Calibration Monitoring Setup'* dialog window.

Pl ot Sel ection
Select event data to be collected and displayed in plot..

But t ons
OK. closes the dialog box and saves any changes made
Cancel closes the dialog box without saving any changes made
Help opens help window.

View facilities
Freeze \ Printing  Count Rate Pages Number of windows
No Yes No 1 4

3.4.15 View Events Count Rate

The command View|Event Count Rate creates window for processing and display of count rate
messages produced by another data views. This window does not receive or process TM packets
directly. Instead, it receives notification about number of event processed by other view. The following
views produce such notification as a result of packed data processing:

* Full Imaging View

* Spectral/Timing View
» Count Rates View

e Spectrum View

e Timing View

* Test View

» Diagnostic View
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» Calibration View
To obtain "Event count rate” plot at least one of view listed above should be active (created).

88 E vents Count Rate _ O] =]
E:JE] Current rate 134 [Events{sec]
320 - _ o I N R
_____________________________________________________________ P I
240 | 1 BT M I
I I I I P VLAY I
160 I N | | I
I N I
a0 I I R I I R
I N I N
i [ ] I S
D0:00 0030 0100 01:E0 0300 0Z30 0300 0330 0400
Time relative to:  0-01:2<:02,0000 [rmin]

Figure 3-22 The "Events Count Rate"" view window.

The menu "Data”, merged to main menu when view window gets focus, lets perform following
commands:

Command Action

Auto Scale Makes Y-axis adjustment to current data for all plots.
Clear All Clears data associated with plot and processing statistic.
Properties Not implemented

About Displays basic information about this view

View facilities

Freeze \ Printing  Count Rate Pages Number of windows
No Yes 1 1

3.4.16 View On Events Message List

This command shows (or hides) the window that display list of "On Event Message Telemetry" records
that was reported in HK packets. Window is created as a child of main application window and is
active during whole program activity.
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On Event Messages List M= E

Total OEMT received: 15

Block: &53 Time: 0-01:27:28,9335 =

Ident: 5 Clazs: Exception

Field #1: 0000 H Hex format

Field #2: 0038 H Decimal farmat

Field #3: 137D H T et format
§Blnc}:: 653 Time: 0-01:27:25,9335 Clear Al
Ident: =) Clazs: Exception ' Propertiss
Field #1: 0000 H
| Field #2: 0038 H about
| Field #3: 4D07 H =

Figure 3-23 The ""On Event Messages list" window.

The menu "Data”, merged to main menu when view window gets focus, lets perform following
commands:

Command Action

Hex format Displays OEMT records as hex numbers
Decimal format Displays OEMT records as decimal numbers
Text format Displays OEMT records as text

Clear All Clears list of OEMT.

Properties Not implemented

About Displays basic information about this view

View facilities

Freeze \ Printing  Count Rate Pages Number of windows
No Yes No Scroll list 1 - Persistent

3.4.17 View Log Command

The View|Program Log command displays list of 32 most recent log events.
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Event Log
Type Time Event Comment
4~k 154526 TM Connected 145.581.24. 55,1075 -
4~k 15:4529  Block received Spectrum 15
44 154529 Block recemed Spectrum 19
4=F 154530 Block recefed Spectrun 20
Ik 154531 Block received Spectrum 21
=k 15:45:31 Block recemved Spectrum 22
4~ 154532 TM Disconnected 0E.
‘d 154541  Setup Changed Network v

Figure 3-24 Program events LOG window.

3.5 Tools menu commands

The Tools menu provides commands to establish TM source connection (one type on the time) and
other miscellaneous commands:

Connect to TM Source Listen for connection to the CORE EGSE
TM socket

Connect to JEM-X EGSE  Connects to EGSE TM data source

Connect to SIS Connects to SIS TM data source

Connect to MOC Connects to MOC TM data source

Log Report Prepares program Log report

Debug Opens connection debugging window

3.5.1 TM Source Connections

The Tools|Connect to xxx commands creates window that services TM source connection via LAN.

See chapter 4.1 "Connecting to telemetry data source” for more details.

3.5.2 Log Report

The JEM-X EGSE software is producing "log" files and saving them in directory: C:\EGSE\BASE.
The new database table (log) is opened for each day with the name LGYYMMDD.DBF. For example
log file name for 25-January-2000 is LG000125.DBF.
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The files are formatted as 'dBase’ tables and each record includes following fields:

e Field1 TIME Event time (HH:MM:SS),

o Field2 TYPE Event code (‘@' + nr) ;(for example "Block Received"),

e Field3 INFO Event info (char [20]) ; additional description,

o Field4 FLAG Flags (category); (Normal, Communication, Setup, Alert, act).

This command generates a report listing of selected part of program events of the specified type during
the specified time. To create report: choose Tools|Log Report to open the report selection dialog box
(see Figure 3-25).

Events Log Report

Start date: |'|5'|-T| 2001 | from time: Iﬂﬂiﬂﬂ:ﬂﬂ
End date: |15-ﬂ1 -20M to time: |23:55:55

Select Events

* by Type [Connections |
 Selected only IBID-::k received jJ

/ aK xl:ancel ? Help

Figure 3-25 Event log report selection dialog box.

1. Enter data in the fields as follows:

Start date: fromtine;
End dat e: to tine:

Enter the range of time during which the transactions you want to appear in the report
occurred. (Defaults to today.) Enter the date using the calendar. Enter the time using the
24 hour clock - 00:00:00 for midnight, 23:59:59 for one second to midnight.

Sel ect Events:
Determines the type of log records, which appear in the report.
Default setting: by type - All.

2. Click "OK." button to generate report.
The computer searches the database for the records that match the conditions and sorts them
into a logical order. You can print the report immediately or preview it on the screen first.

3.6 Setup menu commands

The Setup|xxx commands are used to define various program settings, such as connection parameters
or options that apply to all program windows. Configuration settings are saved into the "EGSE.INI"
file located in system directory (usually: C:\WINDOWS\ or C:\WINNT). The program is delivered
with empty EGSE.INI file, so when first running a default values are used. However, the user can
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change default settings executing "Setup™ menu commands. These settings are recalled whenever the
program is re-started. Although this file is in text format, you should not attempt to manually change it
except where specifically instructed. Where an application is to be made portable, this configuration
file should be copied into the C:\WINDOWS directory of the target computer. The Setup menu
provides commands to execute setup dialogs for:

Network Configures Network connection

HK Data Base Modifies Housekeeping Data Base
(not implemented ver. 3.22)

Operator Data Base Configures program operator Data Base
(not implemented ver. 3.22)

Save setup Saves current setup settings
Restore setup Restores last saved setup

3.7  Window menu commands
The Window menu provides commands to control the position and layout of application's windows.

Cascade

Resize and position all windows in an overlapping pattern. The Window|Cascade command
arranges all document windows from the top-left position of the application's main window so
that the title bar of each is visible.

Tile
Resize and position all windows in an non overlapping pattern.

Arrange Icons

Align all iconized windows along a grid. The Window|Arrange Icons command arranges all
iconized windows into rows along the bottom of the application's main window.

Close All

Closes all windows. If there is active connection to TM source IS prompts .you to disconnect
link.

3.8 Help menu commands

Contents
The Help|Contents displays the help contents page

Using Help
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This command displays information on how to use the JEM-X Help system in Windows.
If you do not know how to use Help in Windows, choose Using Help from the Help menu or

press F1 from an active Help window.

About

This command displays the About JEM-X "Instrument Station™ window that shows copyright

and version information.

About JEM-X Instrument Station

JEM-¥ Instrument Station
Instrument Station Yersion 3.22
Copyright € 1999. All Rights Rezerved.
by Marek Morawski. SREC

Figure 3-26 "Instrument Station’ about window.
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4 Operating procedures

4.1 Connecting to telemetry data source

The “Instrument Station” for JEM-X program can receive TM packets using a unidirectional non-
blocking TCP/IP stream socket. The format of this link is a 16-bit word (Hi byte first) indicating the

length of the subsequent TM Source Packet and TM Packet itself following the length word.

<LEN:16><Raw TM Pct. (binary byte-aligned MSB first)> ..

According to document:

* INT-MA-SAT-0002; ( page B-12)
* INT-SR-AI-0003, Issue 5; (chapter 3.1.1.)

The exception is "MOC" connection when other protocol is used as described in:

INT-MOC-SYS-ICD-0001-OGI document.

There are few possible sources of TM packets:

Source IP address (at DSRI) | Port Number | Connection Type
SIS-OBDH Front End | 130.226.216.165 3100 client socket

SIS Workstation 130.226.216.165 1108 client socket

Core EGSE 194.192.25.1 (Alenial!!) | 3300 server socket
JEMXEGSE 130.226.216.92 5100 client socket
JEMXEGSE?2 130.226.216.93 5100 client socket
JEMXEGSE3 130.226.216.94 5100 client socket
MOC 195.74.166.67 2039 client socket (*)

(*) MOC protocol.
TM Source stream connection procedure:

Run ISJEMX.EXE

SRS

Select/Enter the archive data file: "File Open Dialog".

4.2 Network Configuration Dialog Box

Set IP and Port number (according table above) using command Setup| Network
Activate View processing window (at least one) using commands from View Menu,
Connect to TM Source (OBDH FE or SIS WS): MENU->Tool||Connect to SIS,

This dialog lets you to configure or change the network connection parameters.
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TM Link Connection Setup Ed

- Connection to TM Source

Port Humber: |33I]I]

- Connection to 515

IP Address: 130.226.216.165
Port Number: 1108

- Connection to JEM-X EGSE
IP Address: 130.226.216.94
Port Number: 5100

- Connection to MOC
IP Address: 195 74 166.67
Port Humber: 20339

e 91 ?
V Ok annceI Drefault Help

Figure 4-1 Network Configuration dialog.

| P Address
Enter the internet IP address of the remote TM source. A dotted-decimal version of the
internet address should be entered.
The following IP addresses are used for JEMX-EGSE (DSRI LAN):
e "jemxegse" 130.226.216.92
* "jemxegse2" 130.226.216.93
* "Jemxegse3" 130.226.216.94

Port Nunber
Enter the socket port number (see table above for the default values)
Butt ons
OK. Closes the Dialog Box and saves any changes made
Cancel Closes the Dialog Box without saving any changes made
Default Sets default values (at DSRI)
Help Displays help window.

Note: Before using this command to change your network configuration, be sure to close
'TM Link Status' window. Your changes take effect the next time you start
connection procedure.

4.3 TM Link Status window

When the operator executes one of connection command the new window will be created. This
window receives incoming TM data packets. The current TM source connection status and packet
statistic is displayed.

This window is also responsible for data archiving. Received packets would be saved as IPF files. The
"Status Bar"(see Figure 3-2) of main window shows current archive file and connection status.
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# TM Link Status M= E3

Connected to:
148 .81.24 55,1025

- Last TM Block
Type: Full Imaging
Seqg. nhr: 542

Total: 146

=]
ka

Houszekeeping
Full Imaging
Rezgtricted Img
Count Rate
Spectral fTiming
Timing
Spectrum
Calibration
Diagnostic
Test

Other

=]
19

[ =T — O — I — I — [ — I — Y — [ — |

Errors L]

Figure 4-2 Connection status window.

Figure 4-2 shows the sample of the TM Link status window. If the connection is successful, the most
upper pane displays IP address of source. Last received packet short information will appear in the
pane below.

If the connection is not successful, an error message will appear in the message box.

You can disconnect by right clicking the window and selecting "Disconnect™ command from popup
menu or choosing the Connection|Disconnect command from main menu.

When you close the "TM Link Status” window or EXxit the Application you will be prompted to allow
disconnection. Clicking "YES" button will close window and connection is automatically terminated.
When Connection|Properties command is executed, the following dialog allows you to change data
processing parameters.

TH Link Properties

@ JEMX#1: - JEM-X #2 o ALL

{Hecive from:

| Recive OMLY valid blocks
__| Byte Counter Hi/Low order

/ 0K annceI

Figure 4-3 TM Link Properties window.
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5 Data formats

5.1 LOG file format

The JEM-X EGSE software is producing "log" files and saving them in directory: C:\EGSE\BASE.
The new database table (log) is opened for each day with the name LGYYMMDD.DBF. For example
log file name for 25-January-2000 is LG000125.DBF.

The record of such files includes:

Field1 |TIME |Eventtime (HH:MM:SS)

Field2 |TYPE |Eventcode ('@'+ nr) ; code of log event (for example "Block Received")
Field 3 INFO | Event info (char [32]) ; additional description

Field 4 FLAG |Flags (category); for example ( Normal, Communication, Setup, Alert, act)

There are two windows that displays log records:
a) Event log - list of 32 most recent log events; View|Program Log
b) Event Log Report - list of selected events; Tools|Log Report

It is possible to make report of selected type of events and print them.

5.2 The IPF file format

The Telemetry packets received by JEM-X "Instrument Station" are stored on the disk as IPF format
files. The files has following structure:

V5B Bit Nunber LSB

<0| 1| 2| 3] 4| 5| 6] 7| 8] 9] 10| 11| 12| 13| 14| 15>

Fi |l e Header

<1| 1| 1] 1] 0] 0] 1]1] File Version nunber > Wrd 1
<Instrunent node| Instrument subnode > Word 2
<1| 1| 1] 1] 11|21 Day nbr | Mnth nbr > Wrd 3
<1|1]1] 1] Year nunber > Word 4

< Comrent Words (maxi num = 255) > Wrd 5

< Conment Field Wrd 1 > Wrd 6

< Comment Field Wrd 2 > Word 7

< . >

< Comment Field Wrd N > Wrd N +6
< Total nunber of Packets (N) MSW > Wrd N +7
< Total nunber of Packets (N) LSW > Wrd N+ 8
Packet Data (440 bytes fixed | ength)

< Packet Data Word 1 >

< Packet Data Wrd 1 >

< Ce >

< Packet Data Word 220 >
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The coding convention will be positive integer binary. The first Word (the beginning of the Header) is
Word1

File Header:
The first 5 16-bit words (Words 1 - 5 inclusive) are the File Header. The first 8 bits of the file
header are a code unique from any possible data, so as to avoid confusion.

File Version Number (Word 1 | Bits 8 - 15)
Field holds the file version number for the instrument and mode of the data, encoded in binary.

Instrument Mode (Word 2 I Bits O - 7)
Field holds the binary encoding of the ASCII character for the instrument mode as defined in
table 2. 1 (i.e. the first character of the last column).

Instrument Submode Word 2 | Bits 8 -15)
Field holds the binary encoding of the ASCII character for the instrument submode as defined
in table 2.1 (i.e. the second character of the last column).

Day Number (Word 3 I Bits 7 - 11)
Field holds the day of the month on which the file was created. encoded in binary, This field
contains an integer value which can take the value 1 to 31.

Month Number (Word 3 | Bits 12 - 15)
Field holds the month on which the file was created, encoded in binary. This field contains an
integer value which can take the value 1 to 12.

Year Number  (Word 4 | Bits 4 - 15)
Field contains the year on which the current file was created. the full integer value up to 2047
encoded in binary.

Comment Words (Word 5 I Bits 0 - 15)
This field holds the number of words in the comment string (up to a maximum of 255 words ).

Comment Field (Word 6 up to 261 max. )
This field holds a comment which can be provided with the file. The comment can be from O to
510 ASCII characters long, which translates into a block of 1 to 510 bytes, holding the binary
encoded characters (1 byte per ASCII character). e.g. 'a' is 61 (hex). The field must contain an
even number of bytes so that the last word is a complete word (pad out with a space if
necessary). This field is used to define the instrument configuration in which the IPF file was
produced.

Number of Data Packets (follows Comment Field)
This is the field which shows how many science packets follow in the remainder of the file.
That is, the value of N encoded in binary on 2 words.
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5.3 The Telemetry Packet format

The Packet Data is a block of 220 words (440 bytes), the packet length being fixed for INTEGRAL.
The first 3 words (6 bytes) of the packet data comprise the packet header as defined in the packet
structure definition document :

VBB Bi t Nunber LSB
<0| 1| 2| 3| 4] 5] 6] 7| 8] 9| 10| 11| 12| 13| 14| 15>
Packet Header

<Ver si on Nunber =100| Type=0| Data Field

Header

Fl ag=1| API D

Sequence

< FIl ag=11| Sour ce Sequence Count >
< Packet Length-1 (=433 bytes) >

The next 2 words (4 bytes) of the science packet data comprise the data field header (also as defined in
the packet structure definition document [AD-1])

VSB Bit Nunber LSB
<0| 1| 2| 3| 4] 5] 6] 7| 8] 9| 10| 11| 12| 13| 14| 15>
Packet Data

< Type | Subtype| Spar e >
< Packet Generation Time >
< Packet Generation Tinme >
< SC- TM Header >
< e >
< Conpressed Dat a >
< e >
< CRC >

The JEM-X instrument has several scientific and diagnostic data formats:

TM format APID APID Type/Subtype
(JEM-X “K”) |(JEM-X “J”)
Housekeeping 1536 1664 1/8
Full Imaging 1608 1736 0/8
Restricted Imaging 1624 1752 1/8
Count Rates 1656 1784 3/8
Spectral/Timing 1616 1744 1/0
Timing 1632 1760 2/0
Spectrum 1640 1768 2/8
Calibration 1601 1729 0/1
Diagnostic Dump 1602 1730 0/2
Test 1607 1735 0/7
Idle (Not implemented) 1600 1728 0/0
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5.3.1 FULL IMAGING TM Packets

APID: 1608/1736
Type/Subtype: 0/8
Packet format:

Start (word#) Size (words) Content

0 3 Data Header (OBT of 1.st event in packet)

SC-TM Header

3 1 Number of events in packet

4 1 Grey filter number (coded) for first event in packet
Data

5 211 Compressed events

CRC

217 1

Compressed event format:

Start (bit#) Size (bits) Content

0 8 X position (1..255)

8 8 Y position (1..255)

16 8 Energy

24 8 Delta time relative to previous event, or 255 (see note 2)

32 16 + extra word (Delta time extension) present only when the Delta
time field = 255

Compressed dummy-event "'Grey filter change report™ format: (see note 1)

Start (bit#) Size (bits) Content
0 16 =0
16 16 Grey filter # (0..31)
Comments:
1. When interpreting data in Full Imaging Format one should first check the value of the

first word of each compressed event - when equal to zero, it is Grey filter change report,
otherwise it is normal compressed event.

2. Delta time is shown in units of 1/8192 sec. First event in each packet will have zero
delta time. Next event show time relative to the previous one, which is a true event - not
a Grey Filter change report.

5.3.2 RESTRICTED IMAGING TM Packets

APID: 1624/1752
Type/Subtype: 1/8
Packet format:

Start (word#) Size (words) Content
0 3 Data Header (OBT of 1.st event in packet)
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CRC

217

PR R R R R

206

1

Compressed event format:

Delta OBT of last event (unit = 1/2048 sec)
Number of events in packet

Grey filter number for first event in the image
Grey filter number for last event in the image
X|Y position for first event in packet (X first)
X|Y position for last event in packet

Packet number in sequence (see note 1)

Compressed events

Start (bit#) Size (bits) Content
0 5 Delta position, or 31 (see note 2)
5 3 Energy
8 8 + extra byte (Delta position extension#1 or 255) present only
when the delta position field = 31
16 16 + extra word (Delta position extension#2) present only when the
delta position extension#1 = 255:
Comments:
1. Last packet of the image is marked by 16#8000# added to the field "Packet # in
sequence”.
2. Delta position is a result of substraction two 16-bits words, each of them contains X

position in MSB and Y position in LSB. Before compression events are sorted by words

X|Y.

For each image about 8 TM Packets in Restricted Format are generated. In parallel, but
asynchronously, Count Rate format packets are also produced. DPE will wait maximum about 32
seconds for completing 2580 events needed to construct an image. After this time the image will
be constructed with the available events.

5.3.3 COUNTRATE TM Packets

APID: 1656/1784
Type/Subtype: 3/8
Packet format:
Start (word#) Size (words) Content
0 3 Data Header (OBT of 1.st event in packet)
SC-TM Header
3 8 8 x Grey filter marker (see note 1)
11 1 Number of 125 ms wide Time Channels for Count Rates
including the first one
12 1 Count Rate for the first time channel
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200 400 8-bits delta count rates

1

Format of Grey filter marker (each of the eight):

Start (bit#) Size (bits) Content
0 5 Grey filter # (0..31)
5 11 Number of the time channel in which change of grey filter has

taken place (0..400).

Comments:
1. First of the eight grey filter markers are always present, it has grey filter # on the first 5
bits and zero on remaining 11 bits. It reports the starting grey filter. Other 7 entries are
used only when grey filter changes. Non-zero value means valid grey filter marker.

Count rates are coded on the following way:

* Count rate for the first time channel is put without any compression as the first 16-bits word
#12,

* Count rates for all time channels, but the first, are coded by calculating the difference
between count rates in the current and previous time channel,

» If the difference fits into the range -127+126, than it is placed into the consecutive 8-bit byte.
For negative values U2 coding is used. Otherwise constant 127 is put first, and then full 16-
bits value of the count rate (not the difference). The 16-bits value is placed into the buffer
without any gap, even if it starts with odd byte address.

5.3.4 SPECTRAL/TIMING TM Packets

APID: 1616/1744
Type/Subtype: 1/0
Packet format:

Start (word#) Size (words) Content

0 3 Data Header (OBT of 1.st event in packet)
SC-TM Header

3 1 No. of events in packet

4 1 Grey filter # for first event in packet
Data

5 211 Compressed events
CRC

217 1

Compressed event format:

Start (bit#) Size (bits) Content

0 8 Energy
8 8 Delta time relative to previous event, or 255
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16 16 + extra word (Delta time extension) present only when the Delta
time field = 255

Comments:
Dummy events "Grey Filter Report"” are coded as: Energy = 0, Delta time = Grey Filter. It is
guaranteed that DFEE will never produce real events with zero energy.

5.3.5 TIMING TM Packets

APID: 1632/1760
Type/Subtype: 2/0
Packet format:

Start (word#) Size (words) Content

0 3 Data Header (OBT of 1.st event in packet)
SC-TM Header

3 1 Number of events in packet

4 1 Grey filter # for first event in packet
Data

5 ? 6-bit delta times, or 63. Packed without gaps. Grows upward.
215 ? 16-bit extensions, when 6-bit field = 63. Grows downward.
CRC
217 1
Comments:

Dummy events "Grey Filter Report" are coded as: FFEOQ + Grey Filter. Because of this, the range of the
real delta time is limited to FFDF.

5.3.6  SPECTUM TM Packets

APID: 1640/1768
Type/Subtype: 2/8
Packet format:
Start (word#) Size (words) Content
0 3 Data Header (OBT of 1.st event in packet)
SC-TM Header
3 1 Number of spectra in packet
4 1 Grey filter # for first event in packet
Data
5 210 Up to 10 compressed spectra, 21 words each
215 1 unused
CRC
217 1

Compressed spectrum format:
1 x 16-bit word - Grey filter for last event in spectrum,
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64 x 4-bit fields - counters in 64 energy channels
8 x 8-bit fields - extensions used in case of overflow in 4-bits fields (see note 1)

Total length = 21 words

Comments:
Extension fields are used from left to right.

5.3.7 CALIBRATION TM Packets

APID: 1601/1729
Type/Subtype: 0/1 or 1/8
Packet format:

Start (word#) Size (words) Content

0 3 Data Header (OBT of 1.st event in packet)
SC-TM Header

3 1 Calibration amplitude (see note 1)

4 1 Calibration frequency (see note 1)

5 1 Anode switch status
Data

6 210 Calibration compressed events (up to 6 events)
CRC
217 1

When compressing calibration event the two first words (HK Cycle Counter +Timer Counter) are
compressed to one word - delta time relative to the first event in the packet. Unit of this delta time is
1/8192 sec. All remaining 34 words are copied to the TM packet without compression. Dummy-events
"Calibration amplitude report™ are also reported.

Comments:

Field Calibration amplitude contains 5-th word from the last dummy- event "Calibration
amplitude report” received BEFORE the current TM packet was started. Similarly the field
Calibration frequency contains 6-th word from the same dummy-event. If "Calibration
amplitude report” dummy-event is the first event in the packet, then header fields: Calibration
amplitude and Calibration frequency repeat the data from this dummy-event. If there are
calibration events, but no "Calibration amplitude report” was yet received, zero is reported in
the two fields.

5.3.8 DIAGNOSTIC TM Packets

APID: 1602/1730
Type/Subtype: 8/0 or 8/1/ or 8/2 or 0/7
Packet format:

Start (word#) Size (words) Content

0 3 Data Header (OBT of 1.st event in packet)
SC-TM Header
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3 1 Spare (0)
4 1 Spare (0)
5 1 Anode switch status
Data
6 210 Diagnostic dump events (up to 5 events)
CRC
217 1
Comments:

Full 42-words of event records is copied to TM packet.

5.3.9 TEST TM Packets

APID: 1607/1735
Type/Subtype: 1/8
Packet format:

Start (word#) Size (words) Content

0 3 Data Header (OBT of 1.st event in packet; EGSE Time)
SC-TM Header
3 1 Spare (0)
4 1 Spare (0)
5 1 Spare(0)
Data
6 210 Normal dump (HSL) events
CRC
217 1
Comments:

The TEST packet of this format are produced by EGSE DPE simulator
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